Making Objects using QuickTime Virtual Reality (QTVR) Authoring Studio

Basic Concept - Multiple images of the object are stitched together using the QTVR Authoring Studio to create a 360 degree view of the object.

Setup

1. Use a backdrop, such as a drape of fabric, to help create the illusion that the object is floating in space and that the user is picking up and manipulating the object, rather than just walking around it.  If the object is too dark to contrast well against a black backdrop, use another solid color evenly lit, i.e. white.  You can change the background color later using an image-processing program such as Fireworks or Photoshop.

2. Position the lazy Susan, or any other support system that can be rotated such as a turntable, in front of the drape.  Place the object in the center of the lazy Susan for even rotation. 

3. Mount your camera on a stationary support, such as a tripod.  For simple horizontal rotation, setting your camera on a heavy, level book would also be fine.  For vertical rotation, always use a tripod.  It will allow you to tilt the camera and change it’s distance height from the object for different angled views.

4. Place the tripod or book in front of the object and backdrop.  Position your camera to get the composition and angle of object that you want. (If you are doing only vertical rotation, skip the next step.)

5. (This step is only for horizontal rotation.)  From the reference board, choose how many images you would like to stitch together: 12, 16, or 24.  The reference board is a tool that allows you to quickly divide the rotation evenly for the specified number of images without actually calculating the angle of rotation. The greater the number of images, the smoother the rotation looks.  Find the side of the board with the corresponding reference lines for the number of images you chose.  Place that side of the board parallel to one edge of the lazy Susan, in an area that is easily accessible.

6. You are now ready to start taking pictures.   

Getting Source Material for Only Horizontal Rotation

Source Material – files of images that will be stitched together to form QTVR object.

Using a Regular Film Camera 

1. With a regular film camera, you should include a small reference object that remains in the same position from one frame to the next, to eliminate “jitter”.  Jitter describes the unwanted motion of your object in the final QuickTime VR object due to misalignment of frames.  This usually occurs during the scanning process of your images into digital format.  The reference object will help you align your images perfectly when they are in digital format.   The reference object could simply be a piece of brightly-colored paper pinned to your backdrop.  Adobe Photoshop is one software application that will allow you to align your image and remove the reference object after everything is aligned.

2. After you have everything ready, take the first picture of your object.  Before taking your second picture, grab the right-most corner of the lazy Susan, on the edge that is facing the reference board, and rotate it so that it lines up with the first reference line.  When rotating, you might want to hold the bottom of the stand so that it doesn’t move.  Take another picture.  Using the same corner, rotate it until it lines up with the next reference line.  Take another picture.  Continue following these steps until you reach the last reference line.  The next edge of the lazy Susan should be parallel to the reference board.  You are done with one side.  Repeat this process until all four sides are done and you have all your pictures: 12, 16, or 24.  

3. Once the pictures are developed, scan them into digital files. 

4. Do all your alignment in an image processing application such as Photoshop.  To align your images, you need to put them on separate layers, in order, in Photoshop.  Working from the bottom up, with two layers at a time, change the opacity of the upper layer so that you can see through to lower layer and be able to distinguish the position of the reference object.  

5. Select the upper layer and the move tool. With your mouse over the image, click on your image document.  Hold down the mouse to drag the upper layer around until the reference object in both layers line up with one another.  You could also use your keyboard’s arrow controls to position the upper layer. The keyboard arrows move the selected layer at smaller increments.   Once the upper layer is in place, change it’s opacity back to 100 percent.  Repeat this process until all your images are aligned. 

6. Remove the reference object from your picture using the cloning or paint tool. You can find some helpful Photoshop sites with tutorials on Wellesley College’s Computing page: http://www.wellesley.edu/Computing/computing.html
7. When you are done you need to save each layer as a separate image file. When you name your files, be sure to select a name for each image that reflects the sequence in which the images will be viewed. For the images to be in sequential order, you need to label them image001, image002, and so on. QuickTime VR Authoring Studio puts frames in alphanumeric order.  If you name a series of 24 files - image1, image2, and so on through image24, your files will be out of order in the final object.  QuickTime VR Authoring Studio orders them as image1, image11, image12 through image19, them image2, image20, and so on. 

8. The images are now ready to be brought into QuickTime VR Authoring Studio, where the images will be stitched into a QVTR object.

Using a Digital Camera

1. Before starting, delete all images from the digital camera.  Instructions are included in the digital camera kit.    

2. Mount the camera onto a tripod or book.  Plug in the adapter.  Open the camera and press the button that lets you view the scene on the LCD screen.  This makes it easier for you to see what image you’re taking, instead of squinting into the viewfinder.  Using a digital camera that has a smart media card will also make the whole process faster.  The digital camera automatically names your image files in the order you took them, alphanumerically.  This means that when you download your images into the computer, you do not have to rename them to bring them into QuickTime VR Authoring Studio.

3. After you have everything ready, take the first picture of your object.  Before taking your second picture, grab the right-most corner of the lazy Susan, on the edge that is facing the reference board, and rotate it so that it lines up with the first reference line.  When rotating, you might want to hold the bottom of the stand so that it doesn’t move.  Take another picture.  Using the same corner, rotate it until it lines up with the next reference line.  Take another picture.  Continue following these steps until you reach the last reference line.  The next edge of the lazy Susan should be parallel to the reference board.  You are done with one side.  Repeat this process until all four sides are done and you have all your pictures: 12, 16, or 24.

4. Follow instructions, included with the digital camera kit, on how to download images.  

5. If you kept your camera steady the whole time, you do not have to realign the images in Photoshop.  If the camera or tripod shook at anytime while you were taking your pictures, you might want to realign your images in Photoshop.  See steps 4 – 8 under  the Using a Regular Film Camera section for more information on alignment. 

Getting Source Material for Only Vertical Rotation 

Vertical Rotation is more difficult than horizontal rotation.  It requires the use of a tripod with adjustable height. Because of the added factor of change in distance, between the object and camera, we cannot provide a precise procedure to make vertical rotation as smooth as horizontal rotation. Vertical rotation will rely on estimation and time editing, scaling, and aligning the images in an image editing software in order to stitch together a believable object.  Taking pictures for vertical rotation is similar to taking pictures for horizontal rotation.  Instead of rotating the lazy Susan, you change the height and angle of the camera.  The number of objects for vertical rotation is up to you, but QuickTime VR Authoring Software limits it to a maximum of 36 images for the vertical plane. 

1. Start with the easiest view first; the camera being level with the object.  Take your first picture.

2. Estimate the height that your camera needs to be for the last picture.  With that in mind, you should be able to estimate what heights you want your camera to be for the rest of your images, by dividing the distance between the first height (camera level) and the last height by the number of pictures you want for rotation.  For example, if you’re only want three pictures, then the camera height of 2nd picture should be in the middle, between the camera height of the 1st picture and the 3rdpicture(last picture). 

3. For the second image, adjust the tripod accordingly to change the camera’s height.  Then adjust the angle of the camera, so the object is in view and snap a picture.  If the object is not within view or too small, move the lazy Susan or turntable closer.  

4. For the next picture, adjust the tripod and camera again, so that the camera’s height is higher.  Snap a picture.  Continue following these steps until you get to the last picture.  

9. Align, edit, and adjust images in an image editing software. See steps 4 – 8 under the Using a Regular Film Camera section for more information. You can find some helpful Photoshop sites with tutorials on Wellesley College’s Computing page: http://www.wellesley.edu/Computing/computing.html 

5. Read through the Getting Source Material for Only Horizontal Rotation section for the camera you are using for information on how to save and name your files.   You are now ready to bring your images into QuickTime VR Authoring Studio.     

Getting Source Material for Both Horizontal and Vertical Rotation

If you plan on having both horizontal and vertical rotation of your object, it is best to take the pictures by camera height.  This process is very time-consuming due to the editing and alignment involved.  Please read through the sections “Getting Source Material for Only Horizontal Rotation” and “Getting Source Material for Only Vertical Rotation” for a better understanding of how to take these types of pictures.   

Basic Concept – Set the camera at the first or base height.  Take all the pictures for horizontal rotation at that base height.  Move the camera to the 2nd height.  Take all the pictures for horizontal rotation at the 2nd height.  Move the camera to the 3rd height, take all the pictures for that height.  Continue taking pictures in this manner, by camera height, until you have taken all the pictures you need.

Specific Steps 

1. Adjust the height of your tripod to the first height, level with the camera.  Snap a picture.

2. For horizontal rotation, grab the right-most corner of the lazy Susan, on the edge that is facing the reference board, and rotate it so that it lines up with the first reference line.  When rotating, you might want to hold the bottom of the stand so that it doesn’t move.  Take another picture.  Using the same corner, rotate it until it lines up with the next reference line.  Take another picture.  Continue following these steps until you reach the last reference line.  The next edge of the lazy Susan should be parallel to the reference board.  You are done with one side.  Repeat this process until all four sides are done and you have all your pictures for this camera height.

3. Adjust the height of your tripod to the next height.  Snap a picture.

4. Repeat steps 2 and 3 until you have captured all the images needed to make your object. For example, if you want to make an object with a 16 image horizontal rotation and a 3 image vertical rotation, you will be taking 48 (16 * 3) pictures, that must be edited and aligned in order to be stitched together well into a QuickTime VR object.

5. After you have downloaded/scanned the images to your computer, edit and align them.  Next separate them into folders by height.  For the above example, there would be 3 folders: height1, height2, and height3.  Each will contain 16 images for that height/level.  You are now ready to bring them into QuickTime VR Authoring Studio to be stitched.

Stitching Images in QuickTime VR Authoring Studio

If you do not have access to QuickTime VR Authoring Studio, please speak to Michael Westfort.  QuickTime VR Authoring Studio can only be used on Macintosh computers.

1.  On the computer, double-click on the QuickTime VR Authoring Studio icon. 

2. From the File menu, choose New, then select Object Maker.  A dialog box appears.  Type a name for you Object Maker document and click Save.  An Object Maker Document is a record of your Object Maker Session.  If you quit QuickTime VR Authoring Studio before you make your QTVR object, you can open the document later to continue your work. You can also open the Object Maker document to make changes to an object you’ve already finished. In order to open the document, the computer you’re using must have QuickTime VR Authoring Studio installed. 

3. When the Object Window appears, click Define object.

4. Enter the number of rows and columns in your object and the degrees separating each row and column.  Rows refer to the number of images in the vertical plane, while column refers to the number of images in the horizontal plane. 

For Horizontal Rotation

      If you have a 12-image horizontal rotation, the values would be:     

      1     Row                              0    Degrees Apart

      12   Columns                       30   Degrees Apart    (360 Degrees/12 = 30 Degrees)

      For Vertical Rotation

      If you have a 3-image vertical rotation, encompassing only a 90 Degree, or quarter        

      view, of the object, then the values would be:

      3    Rows                              30 Degrees Apart    (90 Degrees/3 = 30 Degrees)

      1    Columns                           0 Degrees Apart     

      For Horizontal and Vertical Rotation

      If you have a 16-image horizontal rotation, and a 3-image vertical rotation, then the

      Values would be:

     3     Rows                            30 Degrees Apart

     16   Columns                       22.5 Degrees Apart  (360 Degrees / 16 = 22.5 Degrees)

5. Click OK.

6. Right under the Define Object button, there is another larger button with three cubes called Add Files.  Click on this button.   A dialog box with empty squares will appear.  It will contain the corresponding number of rows and columns that you entered when you defined your object.  

7. Locate all the folders that contain your images to make the object.  Using the example under Getting Source Material for Both Horizontal and Vertical Rotation section, the folders would be height1, height2, and height3, each containing 16 files.

8. Scroll down to the last row.  In the above example for horizontal and vertical rotation, it would be row 3.  Select the first square in this row.  It will be labeled R3/C1.

9. Drag the folder height1 into this square window.  This will insert all the images necessary for that row.  

10. Select the first square in the row directly above and drag the folder height 2 into this square window.

11. Continue in this fashion until all the squares contain an image.  When you are done, check that the images are in order.  When you scroll down, the image above should be an image of the object, directly below, but at a higher angle.   As you scroll across, you should see how the object rotates.  To change an image’s position, click on it and drag it to the new position.

12. Make sure that there is a check, X, in the save box next to the Object button.  Click on the Object button to specify the location where the file is to be saved.  Name your file and click Save.  You also have the option of saving it as a QuickTime file, but this is not necessary.  Saving this movie file may save processing time later if you decide to remake the object, but the quality would also be degraded. 

13. Click on Settings.  The Object Maker window appears.  Click on the Compression tab.

14. Click on Settings… and a window will appear.  Select Photo-JPEG from the pull down menu.  Set Quality to High and click OK.  

15. After that is done, click on the Object Tab.  Make sure these boxes are checked, X, Horizontal Controls –Wrap, Vertical Controls – Wrap, Scaleable, and Enable Translation. 

16. Click on the Playback Tab.  You have the option of defining the window size that your object will appear in.  Or you can just check, X the box for Use Frame Size if you are satisfied with its current size. 

17. Next, click on the File tab.  Make sure that you check, X, the box for Flatten to Data Fork.  This will allow the file to be played on a Windows System.  Check the box for Preload.   Click Okay.

For more information about the other values you can select for settings, please refer to chapter 5 in the manual.  In most cases, the values suggested in this documentation should work just fine.

18. You will now see the window that contains all your images.  In the top right corner, is the Make Object button.  Click this button and it will begin stitching your object together.  

19. When the stitching process is done, a playback window with your object appears.  If your object is too big or small, you can adjust its’ width and height to fit the screen.  Remember to make sure the image stays in proportion.

20. You have finished creating your object.  Close the Object Maker window and quit out of QuickTime VR Authoring Studio.   If you need more information, refer to chapter 5 of the QuickTime VR Authoring Studio manual.

